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Overview

Welcome to the DMU Engineering Analysis Review User's Guide. This guide is intended for users who need to become 

quickly familiar with the DMU Engineering Analysis Review Version 5 product.

This overview provides the following information:

●     DMU Engineering Analysis Review in a Nutshell

●     Before reading this guide

●     Getting the most out of this guide

●     Accessing sample documents

●     Conventions used in this guide

DMU Engineering Analysis Review in a Nutshell
DMU Engineering Analysis Review provides an easy to use capability to review the specifications and results of 

engineering analysis studies. 

With this tool, it is possible to read data created with structural analysis products: Generative Part Structural 

Analysis (GPS), Generative Assembly Structural Analysis (GAS), ELFINI Structural Analysis (EST), FEM 

Surface (FMS) or data created in by third party applications integrated through CAA. 

The DMU Engineering Analysis Review workbench is accessible only when these tools are not installed.

In the context of the Digital Mock-Up (DMU), this product takes the integration of Design and Analysis to a new 

level with the ability to perform interference checking and measurements between the deformed shape of parts or 

products under in service loading and the surrounding parts and products. Thus ensuring that required packaging 

and clearances are validated for both nominal conditions and operational conditions. In addition, review can be in 

the form of contour plots or arrow plots, displays can be animated, and HTML reports of results can be created. 



Before Reading this Guide
Before reading this guide, the user should be familiar with basic Version 5 concepts such as document windows, 

standard and view toolbars. We therefore recommend that you read the Infrastructure User's Guide that describes 

generic capabilities common to all Version 5 products. We also recommend that you read the DMU Space Analysis 

User's Guide.

You may also like to read the following complementary product guides, for which the appropriate license is 

required:

●     DMU Navigator User's Guide

●     Part Design User's Guide

●     Assembly Design User's Guide

Getting the Most Out of this Guide
To get the most out of this guide, we suggest that you start reading and performing the step-by-step Getting 

Started section. 

Once you have finished, you should move on the User Tasks section.

The Workbench Description which describes the DMU Engineering Analysis Review workbench, will also certainly 

prove useful.



Accessing Sample Documents
To perform the scenarios, you will be using sample documents contained in the online/anrug/samples folder.

For more information, please refer to Accessing Sample Documents in the Infrastructure User's Guide.



Conventions
Certain conventions are used in CATIA, ENOVIA & DELMIA documentation to help you recognize and understand 
important concepts and specifications. 

Graphic Conventions

The three categories of graphic conventions used are as follows:

●     Graphic conventions structuring the tasks

●     Graphic conventions indicating the configuration required

●     Graphic conventions used in the table of contents

Graphic Conventions Structuring the Tasks

Graphic conventions structuring the tasks are denoted as follows:

This icon... Identifies...

estimated time to accomplish a task

a target of a task

the prerequisites

the start of the scenario

a tip

a warning

information

basic concepts

methodology

reference information

information regarding settings, customization, etc.

the end of a task



functionalities that are new or enhanced with this release

allows you to switch back to the full-window viewing mode

Graphic Conventions Indicating the Configuration Required 

Graphic conventions indicating the configuration required are denoted as follows:

This icon... Indicates functions that are... 

specific to the P1 configuration

specific to the P2 configuration

specific to the P3 configuration

Graphic Conventions Used in the Table of Contents

Graphic conventions used in the table of contents are denoted as follows:

This icon... Gives access to...

Site Map

Split View mode

What's New?

Overview

Getting Started

Basic Tasks

User Tasks or the Advanced Tasks

Workbench Description

Customizing

Reference

Methodology

Glossary



Index

Text Conventions

The following text conventions are used:

●     The titles of CATIA, ENOVIA and DELMIA documents appear in this manner throughout the text.

●     File -> New identifies the commands to be used.

●     Enhancements are identified by a blue-colored background on the text.

How to Use the Mouse

The use of the mouse differs according to the type of action you need to perform.

Use this
mouse button... Whenever you read...

 
●     Select (menus, commands, geometry in graphics area, ...)

●     Click (icons, dialog box buttons, tabs, selection of a location in the document window, 
...)

●     Double-click

●     Shift-click

●     Ctrl-click

●     Check (check boxes)

●     Drag

●     Drag and drop (icons onto objects, objects onto objects)

●     Drag

●     Move

●     Right-click (to select contextual menu)



What's New?

Enhanced Functionalities

Results and Images Generation

Editing Images
The Image edition dialog box has been enhanced.

Results Management

Image Layout
You can define a distance between several images to enhance the visualization.



Getting Started

This tutorial will guide you step-by-step through your first DMU Engineering Analysis Review session, 

allowing you to get acquainted with the product. 

You just need to follow the instructions as you progress.

Entering DMU Engineering Analysis Review Workbench
Generating an Image
Visualizing Extrema

Generating a Basic Analysis Report 

 
These tasks should take about 10 minutes to complete.



Entering DMU Engineering Analysis Review Workbench

 
This first task explains how to enter the DMU Engineering Analysis Review workbench from a CATProduct.

Open the Custom.CATProduct document.
This CATProduct includes an analysis. 

1.  In the specification tree, double-click Analysis Manager. 

 

You automatically enter the DMU Engineering Analysis Review workbench. 

file:///E|/www/bjzdocr14/Doc/online/anrug_C2/samples/Custom.CATProduct


 

In the specification tree, you now have access to the following features:

You are able to: 

❍     browse any of the specifications in order to return information on the computation hypothesis.

❍     manage the display of existing images included in the CATAnalysis document.

❍     generate standard images (mesh, deformed mesh, translational displacement magnitude and Von Mises stress).

❍     edit any image in order to visualize results on pre-defined groups of finite elements.

❍     use Tools (animate, examine results in a cut plane, scale the deformed mesh amplitude, global or local extrema, 
manipulate the color palette, layout images).

 You can now perform the following task, Generating an Image.



Generating an Image

 
This task shows you how to access the Image Generation dialog box. You will then be able to visualize 

on your geometry images of mesh, deformed mesh, translational displacement magnitude and Von 

Mises stress.

To customize your visualization, go to View -> Render Style -> Customize View and select the 

Shading and Materials options in the Custom View Modes dialog box.

1.  In the specification tree, double-click Static Case Solution.

2.  Select the Generate Image icon  from the Tools toolbar.

The Image Generation dialog box appears with the list of the Available Images.



3.  Select the type of image you wish to generate.

In this particular case, select Von Mises Stress (nodal values).

The Deactivate existing images option allows you to suppress the display of existing image, 
and to see only the new created one. For this case, select this option.

4.  Click OK to exit the Image Generation dialog box.

The Von Mises Stress image and tree are displayed.

The specification tree is updated.



Remember that an image is the 3D visualization of analysis results on the Finite Element Modeler mesh. 

 
Now, let's perform the next task, Visualizing Extrema. 



Visualizing Extrema

 

This task shows you how to visualize the extrema on the image

The Von Mises image must be displayed, as seen in the previous task Generate an image.

1.  Click the Search Image Extrema icon . 

The Extrema Creation dialog box is displayed.

For more about Global and Local Extrema, refer to Extrema Detection User task.

2.  Click OK to exit the Extrema Creation dialog box.

Extrema are indicated on the image as shown below:

 

 The next task shows you how to Generate a Basic Analysis Report.



Generating a Basic Analysis Report

 
You will now generate a basic analysis report.

A report is a summary of an object set computation results and status messages, captured in an 

editable file. 

1.  Click the Basic Analysis Report icon  from the Results toolbar.

The Reporting Options dialog box appears.

In the Output directory field, define the path for the output report file. 

In the Title of the report field, enter a specific name.

Selecting the Add created images option adds to the report the results of the Von Mises 

stress image created in the previous task. 

2.  Click OK to exit the Reporting Options dialog box. 



A .html file containing the basic analysis report is displayed in your navigator. 

This .html file contains the following information:

❍     Mesh

❍     Element Type

❍     Materials

❍     Static Case

■     Boundary conditions

■     STRUCTURE computation 

■     RESTRAINT Computation

■     LOAD Computation

■     STIFFNESS Computation

■     SINGULARITY Computation

■     CONSTRAINT Computation

■     NUMBERING Computation

■     FACTORIZED Computation

■     DIRECT METHOD computation

3.  Deformed Mesh
4.  Von Mises Stress (nodal value) 

5.  If needed, save this .html file as a .txt.

Click here to open a .txt report example.

 For more about DMU Engineering Analysis Review, perform the User Tasks.

file:///E|/www/bjzdocr14/Doc/online/anrug_C2/samples/gstextreport.txt


User Tasks

The basic tasks you will perform in the DMU Engineering Analysis Review workbench are the following:

Results and Images Generation
Results Management



Results and Images Generation

Image Generation
Generate Images

Generate images. The list of these images will depend on the Case type.

 
Activate / De-Activate Images

Activate or deactivate an image visualization.

Edit Images
Edit an activated image.

Result Generation
Basic Analysis Report

Create an analysis report.



Generating Images

This task shows how to generate images from a given solution. 

Images can be generated in accordance with the Case type.

 

Static/Frequency/Free Frequency Case Solution

You can use the sample01.CATAnalysis document from the samples directory for this task. 

1.  Select the Generate Image  icon from the Results toolbar.

The Image Generation dialog box appears with the list of the Available Images in accordance 

with the Case type (Static, Frequency, Free Frequency or Buckling).

2.  Select the type of the image you wish to generate.

The dialog box disappears and the image is automatically generated. The feature of the newly 

generated image appears in the specification tree.

file:///E|/www/bjzdocr14/Doc/online/anrug_C2/samples/sample01.CATAnalysis


For the Frequency Case, the mode shapes are arbitrarily normalized displacements. In 

this case, the images of stress and energy results give only tendencies related to these 

mode shapes.

You will find here a table with the Images available in the Image Choice dialog box:

Image Names Meaning Case Solution type

Deformed Mesh Deformed mesh

Static Case
Frequency Case
Free Frequency Case
Buckling Case
Combined Case

Translational displacement 
magnitude

Iso-value image of the 
nodal translation 
displacements magnitude.

Static Case
Frequency Case
Free Frequency Case
Buckling Case

Von Mises Stress (nodal value) Iso-value image of nodal 
Von Mises stress. 

Static Case
Frequency Case



Activating / Deactivating Images

This task shows how to activate or deactivate an image using the contextual menu.

You can modify the current visualization by activating or deactivating images.

Open the Custom02.CATProduct document from the samples directory.

1.  Right-click the Von Mises Stress (nodal value) feature from the specification tree.

file:///E|/www/bjzdocr14/Doc/online/anrug_C2/samples/Custom02.CATProduct


2.  Select the Image Activate/DeActivate contextual menu .

The image is now de-activated: 

The specification tree is updated:



Image Edition

This task shows how to edit images.

You have to activate the image before editing it.

For more details, please refer to Activating / Deactivating Images.

●     Open the sample26.CATAnalysis document from the samples directory.

●     Generate a Von Mises Stress (nodal values) image and a Deformed Mesh image using the 

Generate Image icon.

For more details about image generation, please refer to Generating Images.

You will find in the following table the available tabs and buttons in the Image Edition dialog box.

 Mono-occurrence solutions Multi-occurrence solutions 

Deformed Mesh image

Mesh

Selections

Preview

Mesh

Selections

Occurrences

Preview

file:///E|/www/bjzdocr14/Doc/online/anrug_C2/samples/sample26.CATAnalysis


Other images

Visu

Selections

Preview

Visu

Selections

Occurrences

Preview

Some functionalities of the Image Edition dialog box are not available with the DMU Engineering 

Analysis Review product.

 

Mesh Tab

 

●     On deformed mesh: lets you visualize results in deformed mode.

●     Display free nodes: lets you display free nodes (nodes that are referenced by any element).

●     Display nodes of elements: lets you visualize nodes of elements.

●     Display small elements: lets you choose to display or not the very small elements.

●     Shrink Coefficient: lets you shrink the element visualization.



 

Visu Tab

●     On deformed mesh: lets you visualize the deformation.

●     All the other options in this tab (Types, Criteria, Options... button and options contained in the 

More>> frame) are not available in the DMU Engineering Analysis Review context.

 

Selections Tab



The Selections tab lets you limit the image visualization to a list of entities.

●     Available Groups: gives you the list of the available entities.

The available entities could be:

❍     mesh parts (under the Nodes & Elements set in the specification tree)

❍     pre-processing specifications (under the Restraints, Loads and Masses sets in the 
specification tree)

❍     user groups (under the Groups set in the specification tree)

You can filter the list of the available entities using the Filter groups... contextual menu.

For more details, please click here.

●      button: lets you activate the visualization of all the available entities contained in the 
Available Groups frame.

●      button: lets you activate the visualization of entities selected in the Available Groups frame.

●      button: lets you deactivate the visualization of entities selected in the Activated Groups 
frame.



●      button: lets you lets you deactivate the visualization of all the selected entities contained in 
the Activated Groups frame.

●     Activated Groups: shows you the list of the entities you have activated the visualization.
 

●     Multi-selection is available.
In this case, the resultant selection is the union of the selected entities.

●     You can double-click an entity to activate or deactivate the entity visualization.

●     You can select entities directly in the specification tree or in the viewer.

●     Minimum value and the maximum value of the color palette depend on the selected 
entities.

●     If the Activated Groups field is empty, all the entities listed in the Available Groups 
field will be visualized.

In case of pre-processing specifications, the type of entities contained in a selection may be 

different from a specification to another.

For example:

●     a Clamp symbolizes a list of nodes

●     a Lineic Force symbolizes a list of edges

●     a Pressure symbolizes a list of faces

Filtering Groups

a.  Right-click in the Available Groups frame and select the Filter Groups... contextual menu as 

shown bellow: 

The Filter Groups dialog box appears.



❍     User groups: lets you activate all the groups under the Groups set in the specification 
tree.

❍     1D mesh parts: lets you activate all the 1D mesh parts under the Nodes and Elements 
set in the specification tree.

❍     2D mesh parts: lets you activate all the 2D mesh parts under the Nodes and Elements 
set in the specification tree.

❍     3D mesh parts: lets you activate all the 3D mesh parts under the Nodes and Elements 
set in the specification tree.

❍     Connection mesh parts: lets you activate all the connection mesh parts under the Nodes 
and Elements set in the specification tree.

❍     Specification groups: lets you activate all the entity under the Restraints, Loads and 
Masses sets in the specification tree.

b.  Set the desired options.

c.  Click OK in the Filter Groups dialog box.

For example, with the following analysis specification tree:



●     if you activate the User groups and the Specification groups options, the Available Groups 

frame is updated as shown bellow:

●     if you activate the 3D mesh parts and the Specification groups options, the Available Groups 

frame is updated as shown bellow:



 

Occurrences Tab

The Occurrences tab is available in the Image Edition dialog box only for multi-occurrence solutions.

This tab gives you the list of modes with the associated:

●     frequencies (Hz) for a Frequency Case and a Harmonic Dynamic Response Case

●     Buckling factor for a Buckling Case



●     Time (s) for a Transient Dynamic Response Case



You can then activate separately each mode of the multi-occurrence solution.

 

Preview button
 

By default, the visualization process is launched after each modification in the Image Edition dialog 

box.

The Preview button allows you to launch the visualization process after performing all the needed 

changes in the Image Edition dialog box.

The Preview button is available only if you deactivate the Automatic preview mode option in 

the Options dialog box (Tools -> Options...-> Analysis and Simulation -> Post-

Processing).

For more details, please refer to the Customizing - Post Processing section of the Generative 

Structural Analysis User's Guide.



Basic Analysis Report

This task shows how to generate a Report for Computed Solutions: 

●     from DMU Engineering Analysis Review workbench 

●     from DMU Navigator workbench 

A Report is a summary of an objects set computation results and status messages, captured in an editable file.

Once an objects set has been computed (meaning that the user-defined specifications have been converted into solver 

commands, which in turn have been transformed into degree of freedom data and processed), all data contained in the 

object are ready for use in the subsequent finite element computation process and the object can be analyzed. 

You can use the sample02_Image_Loads.CATAnalysis document. 

 DMU Engineering Analysis Review 

1.  Click the Basic Analysis Report  icon.

The Reporting options dialog box appears.

Pressing the button on the right gives you access to your file system for defining a path for the output Report 
file. You can edit the title of the report. 

2.  Set the path and click OK to close the dialog box.

file:///E|/www/bjzdocr14/Doc/online/anrug_C2/samples/sample02_Image_Loads.CATAnalysis


A HTML file containing the Report of the Static Case Solution objects set computation is displayed.  It contains 
information relative to the static computation procedure:

❍     restraints translation

❍     loads translation

❍     numbering

❍     SPC singularity auto-fixing

❍     constraints factorization



❍     stiffness computation

❍     constrained stiffness and loads computation 

❍     stiffness factorization

❍     displacement computation

❍     reactions computation

❍     equilibrium checking

For example, you will find the image of the Von Mises Stress (nodal value) you previously generated.

3.  If needed, you can perform the same operation with the Frequency Case.

A HTML file containing the Report of the Frequency Case Solution objects set computation is displayed.  It 
contains information relative to the frequency computation procedure. In complement to the Static Case 
Report, one finds items such as:

❍     a list of vibration frequencies 

❍     a list modal participation factors

4.  Click OK to exit the Report application. 

In addition to the HTML Report file, the program also generates a Text file ready for user editing.
Click here to open the .txt file: sample02_Image_Loads.txt.

5.  Click here to open the .txt file: sample02_Image_Loads.txt.

file:///E|/www/bjzdocr14/Doc/online/anrug_C2/samples/sample02_Image_Loads.txt
file:///E|/www/bjzdocr14/Doc/online/anrug_C2/samples/sample02_Image_Loads.txt


 

 DMU Navigator 

1.  Select Start -> Digital Mockup -> DMU Navigator from the menu bar.

OR

1.  From any of the DMU workbenches (except DMU Engineering Analysis Review), select the Tools -> 

Publish command.

You can now use the available Publishing tools (Start Publish icon  from the DMU Data Navigation toolbar or 

Tools->Publish->Start Publish command from the menu bar).

With the Publishing Tools, you can create a DMU html publish report with snapshots, features, text, VRML. In addition, 

if you select the Publish Feature icon and then the Analysis current view, a link to the Analysis Basic report will be 

automatically created in DMU publish report.



Click here if you wish to enter both the DMU Navigator and Generative Part Structural Analysis report.

For more details on Publishing Tools, see DMU Navigator User's Guide.

file:///E|/www/bjzdocr14/Doc/online/anrug_C2/anrugbt1000.htm


Results Management

Post-processes results and images
Animate Images

Animate an image. 

Cut Plane Analysis
Examine results in a plane cut. 

Amplification Magnitude
Scale the deformed mesh amplitude.

Extrema Detection
Search for global or local extrema of the analyzed field. 

Information
Give information on image.

Manipulate the Color Palette
Edit the Palette on Von Mises display.

Images Layout
Tile layout images.



Animating Images

This task shows how to animate one image or a mulit-selection of images.

Image Animation is a continuous display of a sequence of frames obtained from a given image. Each frame 

represents the result displayed with a different amplitude. The frames follow each other rapidly giving the 

feeling of motion.

By animating a deformed geometry or a normal vibration mode, you can get better a insight of the behavior of 

the system. Sometimes you gain a more thorough understanding of the system behavior.

You can use the sample26.CATAnalysis document: you created a Von Mises Stress image. 

1.  Click the Animate icon .

The image is animated with default animation parameters and the Animation dialog box appears. 

You access any point of the simulation at random.

2.  Click the Pause button .

The animation is interrupted. 

file:///E|/www/bjzdocr14/Doc/online/anrug_C2/samples/sample26.CATAnalysis


❍     Slider: lets you manually select the desired step.

❍     Play:

■     : Jump to Start

■     : Play Backward

■     : Steps Backward

■     : Pause

■     : Steps Forward

■     : Play Forward

■     : Jump to End

❍     Change loop mode:

■     : plays once in one shot

■     : repeats play non stop 

■     : repeats play and reverse non stop

For a smooth animation enter the maximum value (20) as Steps number option and activate the 
Repeat play and reverse non stop button.

❍     Steps number: makes the animation more or less fluent.

❍     Speed: lets you manually define the desired speed.

❍     More: this button expands the Animation dialog box.



The options available in this part of the dialog box depend on the solution type (mono-occurrence 

or multi-occurrence).

Mono-occurrence solutions:

By default, you can access the following options:

■     : use non symmetrical animation (default value).

■     Interpolate values: animate the interpolated values of the activated image.

■     Interpolate displacements: animate the interpolated displacements of the activated 

image.

■     : use symmetrical animation.

Multi-occurrence solutions:

■     All occurrences: animate all the occurrences of the solution.

When activated, this option allows you to choose whether you want to memorize frames: 

The frame animation will be speed driven but memory consuming. If you do not activate the 

Memorize frames option, the frame animation will need less memory but will be slower.

■     One occurrence: animate the selected occurrences of the solution.



■     : this button lets you select the previous occurrence.

■     : this button lets you select the next occurrence.

■     : this button lets you select the desired occurrence using the Frequencies dialog box.

When clicking this button, the Frequencies dialog box appears.

Multi-selection is not available in the Frequencies dialog box.

■     : use non symmetrical animation (default value).

■     Interpolate values: animate the interpolated values of the activated image.

■     Interpolate displacements: animate the interpolated displacements of the activated 

image.

■     : use symmetrical animation.

3.  You can now change the animation parameters to the desired values.

4.  Click the Play forward button .

5.  Click Close in the Animation dialog box.

 



Cut Plane Analysis

This task shows how to use the Cut Plane Analysis capability. 

Cut plane analysis consists in visualizing results in a plane section through the structure.

By dynamically changing the position and orientation of the cutting plane, you can rapidly analyze the 

results inside the system.

You can use the sample26.CATAnalysis document: you created a Stress Von Mises image. 

 1.  Click the Cut Plane Analysis icon .

The Cutting Plane automatically appears.

The Cut Plane Analysis dialog box is displayed.

file:///E|/www/bjzdocr14/Doc/online/anrug_C2/samples/sample26.CATAnalysis


The compass is automatically positioned on the part, with a Cutting Plane normal to its 

privileged direction. 

Note that if the compass is already positioned on the view, the normal of the compass is taken 

into account as the default normal of the cutting plane.

2.  Handle the compass using the cursor and rotate or translate the Cutting Plane.

For this, you will select an edge of the compass and drag the cursor. As you modify the plane 

position, results in the Cutting Plane are automatically updated. 

3.  Activate the View section Only option in the Cut Plane Analysis dialog box to see the section 

relatively to the position of the cutting plane.



4.  De-activate the Show cutting plane option  in the Cut Plane Analysis dialog box to see only 

the boundary of this cutting plane.

5.  Click CLOSE in the Cut Plane Analysis dialog box to exit the Cut Plane application.



●     The cut plane capability is also available for Frequency Solutions.

●     All the existing images will be cut, if needed.

 



Amplification Magnitude

This task shows how to use the Amplification Magnitude functionality.

Amplification magnitude consists in scaling the maximum displacement amplitude for visualizing a 

deformed mesh image. 

You can either choose a large scaling coefficient to zoom on the deformed geometry or a small 

coefficient to obtain a realistic visualization. 

You can use the sample26.CATAnalysis document from the samples directory: you created a Stress Von 

Mises image. 

1.  Click the Amplification Magnitude icon .

The Amplification Magnitude dialog box appears.

❍     Scaling factor: lets you modify the amplification magnitude for deformation visualization 
using a constant scale factor

file:///E|/www/bjzdocr14/Doc/online/anrug_C2/samples/sample26.CATAnalysis


■     Cursor: lets you dynamically modify the scale factor from 0 to a maximal value

■     Factor: lets you specify the scaling factor

■     Default: lets you return to the default scaling factor

❍     Maximum amplitude: lets you modify the amplification magnitude for deformation 
visualization using a constant maximum amplitude (artificial)

■     Length: lets you specify the value of the maximum allowed deformation on the image 
(in mm)

The default unit for the Length option is fixed in the Options dialog box 

(General -> Parameters and  Measure -> Units tab).

For more details, please refer to the Infrastructure User's Guide.

■     Default: lets you return to the default amplification magnitude

❍     Set as default for future created images: lets you apply the modified amplification 
magnitude parameter (factor or length) to the future created images

To summarize:

maximum amplitude = real deformation * scaling factor



To visualize the real deformation, the scaling factor must be equal to 1.

2.  Select the Scaling factor option in the Amplification Magnitude dialog box.

3.  Enter 300 as Factor value and press Enter.

As a result, the deformation is increased.

4.  Click the Default button and then click OK in the Amplification Magnitude dialog box.

The image retrieves the default deformation.

    



Extrema Detection

 
This task shows how to use the Extrema Detection capability. 

Extrema Detection consists in localizing points where a results field is maximum or minimum. You can ask the 

program to detect either one or both global extrema and an arbitrary number of local extrema for your field. 

You can use the sample26.CATAnalysis document: you created a Stress Von Mises image. 

1.  Click the Search Image Extrema  icon. 

The Extrema Creation dialog box is displayed.

You can ask the program to detect given numbers of global (on the whole part) and/or local (relatively to 

neighbor mesh elements) extrema at most, by setting the Global and Local switches.  

❍     If you activate the Global option, you will launch the detection of the minimum and maximum global 

extrema. Global means that the system will detect all the entities which have a value equal to the 

Minimum or Maximum value.

❍     If you activate the Local option, you will launch the detection of the minimum and maximum local 

extrema. Local means that the system will search all the entities which are related to the Minimum or 

file:///E|/www/bjzdocr14/Doc/online/anrug_C2/samples/sample26.CATAnalysis


Maximum value compared to the two-levelled neighboring entities.

2.  Click OK to exit the dialog box.

A new image corresponding to the default settings is displayed, with two arrow boxes locating the points of 

absolute extremum for the current field and containing information about the detected value.

The Extrema object set containing the two Global Extrema appears under the current Image object in the 

specification tree.

3.  Double-click the Extrema object set in the specification tree.



The Extrema Creation dialog box appears.

You can modify the objects set by setting the Global and Local switches. 

4.  Set the Global switch to off and the Local switch to on.

The boxes locating the global extrema disappear, and symbols locating the local extrema are visualized.

The Extrema objects set in the specification tree now contains, in addition to the two Global Extrema 

objects, as many Local Extremum (Maximum or Minimum) objects as you have required.

5.  Double-click one of the Local Extremum objects in the specification tree.



The Image Extremum Editor dialog box is displayed. 

6.  Set the Show Label option to on and then OK, in the Image Extremum Editor dialog box.

A new arrow box is visualized, locating the position of the corresponding point and containing information 

about the detected value.

7.  Click OK to exit the Image Extremum Editor dialog box.

The extrema detection capability is also available for images obtained under Frequency and Buckling Solutions.

 



Manipulating the Color Palette

This task shows how to edit the Palette on Von Mises display.

The von Mises stresses, the Displacements, the Precision, the Principal Stress distributions are 

employed along with a Color Palette.

You can use the sample26.CATAnalysis document: you created a Stress Von Mises image. 

1.  Click on the color palette once.

The color palette is now active (the part viewer is deactivated and the part is shaded) and can 

be manipulated: either moved using the middle mouse button or zoomed using the middle 

mouse button and then the left mouse button.

2.  Move the palette.

file:///E|/www/bjzdocr14/Doc/online/anrug_C2/samples/sample26.CATAnalysis


Use the middle mouse button and drag the palette to the desired location. 

3.  Zoom in and zoom out the palette.

Use the middle mouse button, then the left mouse button and zoom either in or out the palette 

to the desired size.



 



Information

This task shows how to get information on one or more images and extrema you generated.

You can use the sample26.CATAnalysis document.

You have to activate an image.

1.  Click the Information icon .

2.  Select the Von Mises Stress image in the specification tree.

The Information dialog box appears.

file:///E|/www/bjzdocr14/Doc/online/anrug_C2/samples/sample26.CATAnalysis


3.  Click Close in the Information dialog box.

4.  Create extrema.

For more details, please refer to Extrema Detection.

5.  Click the Information icon.

6.  Click Close in the Information dialog box.



Images Layout

 
This task shows how to tile layout images.

Generated images corresponding to analysis results are superimposed into one image that cannot be 

properly visualized. You can tile these superimposed images into as many layout images on the 3D 

view.

You can use the sample13.CATAnalysis document from the samples directory for this task.

Make sure at least two images were created and activated.

1.  Click the Images Layout icon .

The Images Layout dialog box appears.

file:///E|/www/bjzdocr14/Doc/online/anrug_C2/samples/sample13.CATAnalysis


❍     Explode: 
■     Along: lets you specify the axis (X, Y or Z axis) or the plane (XY, XZ or YZ 

plane) along which you want to explode the image visualizations.

■     Distance: lets you specify the distance between two images.
The Default button lets you retrieve an optimum Distance value.

❍     Default: lets you retrieve the default superposed visualization.

The Default option is only available if you have already explode the image 

visualization.

2.  Select the Y axis and enter 100mm as Distance value.

3.  Click OK in the Images Layout dialog box.

The images are tiled along the Y axis.



4.  Click the Images Layout icon  and select the Default option as shown bellow:

5.  Click OK in the Images Layout dialog box.

You retrieve a superimposed visualization.

●     You can animate one or more of these images, if desired.

●     Be careful: the cutting plane will cut all the images.



Workbench Description

This section contains the description of the icons and menus which are specific to the DMU Engineering 

Analysis Review workbench.

You can click the sensitive areas on this image to see related documentation.

Menu Bar
Toolbar



Menu Bar
This section presents the Tools menu in the DMU - Analysis Engineering Review product.

Tools Menu
For...  See...

Basic Analysis Report  Basic Analysis Report 

Animate an Analysis Image  Image Animation 

Cut Plane Analysis  Cut Plane Analysis 

Deformation Scale Factor  Amplitude Modulation 

Image Extrema  Extrema Detection 

Image Layout  Images Layout 

 



Toolbar
The Results and Tools toolbars contain the following tools to manage results: 

See Generating Images

See Reporting

See Animating Images

See Cut Plane Analysis

See Amplitude Modulation

See Extrema Detection

See Information

See Images Layout



Index 
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